ROCKFLY-MINI

RockFLY Mini is an open source new generation user-friendly rocket card with
Wifi/Bluetooth feature with two-stage recovery system in high-model rocketry.

Thanks to the RockFLY Mini Wifi/Bluetooth feature, it interfaces to the user. You can
access the information of pre-flight sensor data, battery voltage, flash occupancy rate
and whether e-matchs are attached, and change the main parachute altitude, the
metric/imperial measurement system and delete the flash memory. You can even test
the card's e-match connected to the Drogue and Main line by firing them over the
interface.

You can access the latest flight statistics data after the flight and download or delete the
data recorded during the flight in .csv format.

RockFLY Mini Arduino appeals to a wide audience due to its programming through IDE.
With its open source code, it allows users to access flight codes and make changes.
Therefore, it supports users to develop different experiences on the card.
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Basic Features

Software : Open Source

Weight :13 gr

IDE : Arduino

Platform : ESP32 WIFI/Bluetooth

MCU : ESP32-S

Flash : 16MB (3MB APP/12.9MB SPIFFS)

Ram : 520 kB

Operating Frequency : 80-240 Mhz

Operating Voltage : 3.3 Volt

Input Voltage : 2.7 (min) - 16 (max) Volt on Bat Terminal (Buck-Boost
regulator with power good)

Output current : Do not exceed 7 amper

Sensor : MS5611 (pressure and temperature)
Maximum altitude : 100.000 feet

Altitude resolution : 10 cm

Resolution temperature : 0.01 °C

CPU Power Consumption (Idle) : ~70 mA

Sample rate : 30 samples per second in flight mode

INSTALLATION

1. Install Arduino IDE

Download and install Arduino IDE. If you have already installed Arduino, please check
for updates. Its version should be at least v1.8.19 or newer.


https://www.arduino.cc/en/Main/Software

2. Install ESP32

e Open the File > Preferences >... menu item as follows:

&) sketch_oct2fa | Arduine 1816 — O x
File Edit Sketch Tools Help

Mew Ctrl+M

Open... Ctrl+0

Open Recent

Sketchbook

Examples s»pode here, to run once:
Close Ctrl+W

Save Ctrl+5

Save As.., Ctrl+5Shift+5

Page Setup  Ctrl+Shift+P de here, to run repeatedly:
Print Ctrl+P

Preferences  Ctrl+ Comma

Cuit Ctrl+C

e Enter the following into the “Additional Board Manager URLSs” field:

https://raw.githubusercontent.com/espressif/arduino-
esp32/gh-pages/package esp32 index.json

Note: if you already have the ESP8266 boards URL, you can
separate the URLs with a comma as follows:

https://raw.githubusercontent.com/espressif/arduino-
esp32/gh-pages/package esp32 index.json,
http://arduino.esp8266.com/stable/package esp8266com
index.Jjson



Settings  Network

Sketchbook location:

Ci\Wsersyunus\Documents\Arduino Browse
Editor language: English (English) w | (requires restart of Arduino)
Editor font size:

& Additional Boards Manager URLs bt

Interface scale:

Enter additional URLs, one for each row
Theme:

https://raw_githubusercontent comfdamellis/attinyg/ide-1. 6. x-boards-manager/package damellis _attiny inder &

Show verbose output https://raw. githubusercontent com/espressif/arduine-espdl/ gh-pages/package_espll_index.j :ocnl

Compiler warnings: he
£ >

Display line numbe

Verify code after |

Check for updates

[ Use accessibility features

Click for a list of unofficial boards support URLs

oK Cancel

Additional Boards Manager URLs | on,, https: //fraw. githubusercontent. comfespressif/arduino-esp32/gh-pages package_esp32_index. json I
Maore preferences can be edited directly in the file

C:\sersyunus\AppData'Local\Wrduino 15\preferences. txt

(edit only when Arduine is not running)

oK Cancel

e Open the Boards Manager. Go to Tools > Board > Boards Manager...

&) sketch_oct26a | Arduine 1.8.16 -
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_oct26a Fix Encoding & Reload
1|woid setn Manage Libraries... Ctrl+Shift+|
2 // put Serial Monitor Ctrl+Shift+M
: Serial Plotter Ctrl+Shift+L

5 ESP32 Sketch Data Upload
& woid looj WiFi101 / WiFiNINA Firmware Updater

7 /f put
ESP32 Sketch Data Upload
8} Board: "Arduine Yian" : Boards Manager...
Port : Arduino AVR Boards ¥
Get Board Info ATtiny Microcontrollers  *
i ]
Programmer: "Arduino as [5P" : ESP32 Arduino

Burn Bootloader




e Search for ESP32 and press install button for the “ESP32 by Espressif Systems®:

& Boards Manager >
Type |All w | |BSp32
Arduino ESP32 Boards A
by Arduino

Boards included in this package:
Arduino Nano ESP32.
Maore Info

esp3d

by Espressif Systems version 2.0.14 INSTALLED
Boards included in this package:

ESP32 Dev Board, ESP32-52 Dev Board, ESP32-53 Dev Board, ESP32-C3 Dev Board, Arduino Nano ESP32.
More Info

Select version Install Remove

W
Close
e Open RockFly zip file and open rockfly_board_definitions.txt file and then
copy the all texts.
i RockFly.zip (deneme kopyasi)
Dosya Komutlar  Araglar  Sik Kullamilanlar - Secenekler  Vardim
B R EDie \008=
— I =SOON < .
Ekle Hedefe Ayikla  Sina Garintdle Sil Bul Sihirbaz Bilgi Virds Tara  Agiklama SFX
T ‘m RockFly.zip - ZIP arsivi, agilmig boyut 804,651 bayt
Ad - Boyut Sikr, boyut  Tar
x File folder
rockfly_libraries T07,012 403,924  File folder
RockFlyMini 91,612 20,340 File folder
@Iarge_spiffs_'lBMB_HD_Dta.cw 218 129 Microsoft Excel Virgdlle ...

rockfly_board_definitions.tet 5,809 Text Document




E rockfly_beoard_definitions.bxt - Notepad
File Edit Format View Help

RockFLY .menu.FlashSize.16M=16MB (128Mb)
RockFLY.menu.FlashSize.16M.build.flash_size=16MB

RockFLY.menu.UploadSpeed.921688=921600
RockFLY .menu.UploadSpeed.921688.upload. speed=921600)
RockFLY.menu.UploadSpeed.115288=115208
RockFLY .menu.UploadSpeed.115288.upload. speed=115200)

~menu. Unda
~menu.
.menu. Cut 2ed=256000
.menu . Copy

menu . Paste
.menu . Delete
~menu.
-menu. Select All 38
~menu.
.menu. Right to left Reading order 38

Show Unicode control characters

menu. Insert Unicode control character »
.menu. _RUNNING CORE=1
.menu. Open IME

-menu.

-menu.

-menu.

-menu.

RockFLY.menu.EventsCore
RockFLY.menu.EventsCore.8=Core B
EventsCore.

RockFLY.menu.Debuglevel.none=None
RockFLY.menu.Debuglevel.none.build.code_debug=0
RockFLY.menu.Debuglevel.error=Error|
RockFLY.menu.Debuglevel.error.build.code debug=1
RockFLY.menu.Debuglevel .warn=Warn
RockFLY .menu.Debuglevel .warn.build.code debug=2
RockFLY .menu.Debuglevel.info=Info
RockFLY.menu.Debuglevel.info.build.code debug=3
RockFLY.menu.Debuglevel.debug=Debug
RockFLY.menu.Debuglevel.
RockFLY.menu.Debuglevel.verbose=Verbose
RockFLY .menu.Debuglevel.

RockFLY.menu.EraseFlash.none=Disabled
RockFLY.menu.EraseFlash.

RockFLY.menu.EraseFlash.all=Enabled
EraseFlash.all.upload.erase_cmd=-e

Reconversion

Search with Bing...

.1.build.event core=-DARDUINO_ EVENT_RUNNING_CORE=1

@.build.event_core=-DARDUINO_EVENT_RUNNING CORE=8)|

_RUNNING CORE=@

Ln 144, Col 63

100%  Windows (CRLF)

UTF-8




e And then find the Esp32 boards file in your computer...

C:\Users\<username>\AppData\Local\Arduinol5\packages\esp32\hardwa
re\esp32\2.0.14

Cores Dosya klasard
libraries 4.10.2023 20:31 Dosya klasdri
tools 4.10.2023 20:31 Dosya klasard
variants 4.10.2023 20:31 Dosya klasari
D boards.tet 19.10.2023 18:14 Metin Belgesi 1.197 KB
| package.json 4.10.2023 20:31 JSOM Kaynak Dos... 1KB
D platform.tct 4.10.2023 20:31 Metin Belgesi 91 KB
D programmers.tet 4.10.2023 20:31 Metin Belgesi 1KB

e Open the boards file and paste the RockFly board definitions that you copied
from the zip file to the bottom of the boards file.

info=Info -

[

cores atd147 s3.menu.Debuglevel.
libraries atdl1l47_s3.menu.Debuglevel.info.build.code_ debug=3
tools atd147_s3.menu.Debuglevel.debug=Debug
variants atd14? s3.menu.Debuglevel.debug.build. code debug=4
£ boardsxt atd147_s3.menu.Debuglevel.verbose=Verbose
. atd147 s3.menu.Debuglevel.verbose.build.code debug=5
| package.json
=] platform. it atdl1l47_s3.menu.EraseFlash.none=Disabled
=l programmers.tct atd147 s3.menu.EraseFlash.none.upload.erase_cmd=
atd147_s3.menu.EraseFlash.all=Enabled
atd14?_s3.menu.ErasefFlash.all.upload.erase_cmd=-e

.bootloader. tool=esptool_py
.bootleoader.tool.default=esptool py

.upload.tool=esptool_py
-upload.tool.default=esptool_py
.upload.tool.network=esp ota

RockFLY .
RockFLY.

upload.maximum size=1318728
upload.maximum_data_size=3276808

5t 26483, 5tn 23 100%  Unix (LF) UTF-38




e After, in RockFly zip file copy the large_spiffs_16MB_no_ota.csv file and go to
the partitions file and paste.

C:\Users\<username>\AppData\Local\Arduinol5\packages\esp32\
hardware\esp32\2.0.14\tools\partitions

» esp3d » 204 » tools » partitions v | QO 22 partitions klasériinde ara
Ad - Degistirme tarihi Tir Boyut
@ app3M_fatiM_16MB.csv 4.10.2023 20:31 Microsoft Bxcel Vi, TKB
g app3M_fatiM_fact312k_16MB.csv 4102023 20:31 Microsoft EBxcel Vi... 1KB
” @ app3M_spiffsOM_fact312k_16ME.csv 4.10.2023 20:31 Microsoft EBxcel Vi... 1KB
* bare_minimum_2MB.csv 4,10.2023 20:31 Microsoft Bxcel Vi.. 1EKB
- D boot_app0.bin 4.10.2023 20:31 BIM Dosyasi 2 KB
D default.bin 4102023 20:31 BIM Dosyas 3KE
@ default.csv 4.10.2023 20:31 Microsoft EBxcel Vi... 1KB
@ default_8MB.csv 4102023 20:31 Microsoft Excel Vi... 1KE
@ default_16MB.csv 4.10.2023 20:31 Microsoft EBxcel Vi... 1KB
@ default_ffat.csv 4.10.2023 20:31 Microsoft Excel Vi.. 1KE
ﬁ’at.cs'.r 4102023 20:31 Microsoft EBxcel Vi... 1KB
@ huge_app.csv 4.10.2023 20:31 Microsoft Bxcel Vi, TKB
large_fat_32MB.csv 4102023 20:31 Microsoft EBxcel Vi... 1KB
@ large_littlefs_32MB.csv 4.10.2023 20:31 Microsoft EBxcel Vi... TKB
large_spiffs_16MB.csv 4102023 20:31 Microsoft Excel Vi... 1KB
@ large_spiffs_16MEB_no_ota.csv 19.10.2023 17:52 Microsoft Excel Vi... 1TEKEB
max_app_BMB.csv 4102023 20:31 Microsoft Excel Vi... 1KB
@ min_spiffs.csv 4.10.2023 20:31 Microsoft EBxcel Vi... 1KB
@ minimal.csv 4102023 20:31 Microsoft Excel Vi... 1KE
@ no_ota.csv 4.10.2023 20:31 Microsoft EBxcel Vi... 1KB



e Open RockFly zip file and open rockfly_libraries folder. Copy all files and go to
Arduino library folder and paste.

C:\Users\<username>\Documents\Arduino\libraries

Mame

ESP32Time
ESPAsyncWebServer-master
ms3611_spi
SimpleKalmanFilter

Vector

e Lastly restart the Arduino

Date modified Type Size
10/26/2023 11:12 AM File folder
10/26/2023 11:22 AM File folder

10/26/2023 11:13 AM File folder
10/26/2023 11:14 AM File folder
10/26/2023 11:15 AM File folder

IDE.

e After in the RockFly zip file you can see RockFlyMini folder. It is RockFly code
folder. You can open and compile it.

| RockFly.zip (deneme kopyasi)

Dosya Komutlar  Araglar  Sik Kullamilanlar - Secenekler  Yardim

8 5 C

O €& @ @ 8 =

Ekle  Hedefe Ayikla  Sina  Gérdntile Sil Bul Sihirbaz Bilgi Virds Tara  Agiklama SFX
T | RockFly.ziphRockFlyMini
Ad Boyut Stkr, boyut - Tir
. File folder
@RDckFI}rMini.ino 91,812 200940 Arduino file



3. Configure ESP32

e Goto Tools > Board >Esp32 Arduino >RockFly

File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_oct! 93 Fix Encoding & Reload
1 d sety Manage Libraries... Ctrl+Shift+I
2 /] put Serial Monitor Ctrl+Shift+M
: Serial Plotter Ctrl-+Shift+ L

5 ESP32 Sketch Data Upload
WIFi101 / WiFiNIMA Firmware Updater

ESP32 Sketch Data Upload

rs
9} Board: "Arduino Uno" 1 Boards Manager... DPU ESP32
Port I Arduino AVRBoards 3 oonoff DUALRS
Get Board Info ATtiny Microcontrollers 3 Lion:Bit Dev Board
ESP32 Arduino | EEy

Programmer: "Arduine as I5P AirM2M_CORE_ESP32C3

XIAQ_ESP32C3

XIAQ_ESP3253

Connaxio's Espoir

CNRS AW2ETH

Department of Alchemy MiniMain ESP32-52
Bee Data Logger

Bee Motion 53

Burn Bootloader

Bee Motion

Bee Motion Mini

Bee 53

unPhone 7

unPhone &

unPhone 9

Cytron Maker Feather AloT 53
RedPill(+) ESP32-53
ESP-C3-M1-I-Kit

RoboHeart Hercules
VALTRACK_V4 VTS_ESP32 C3
VALTRACK_V4 MFW_ESP32 C3
Edgebox-ESP-100

Crabik Slot ESP32-53

Mebula 53

Lion:Bit 53 STEM Dev Board
4D Systemns gend-ESP32 16MB Modules (ESP32-53REn16)
Mamine Rosso

Mamine Arancio

Arduino Nano ESP32
IOXESP32

IOXESP32PS

ATD1.47-53

RockFLY




e Settings should be like this:

File Edit Sketch Tools Help

Auto Forrmat Ctrl+T
Archive Sketch

sketch_oct193 Fix Encoding & Reload

1|wvoid sety Manage Libraries.., Ctrl+Shift+|

2 /) put Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

5 ‘ E5P32 Sketch Data Upload

o woid looj WiFi101 /S WiFiNINA Firmware Updater
7|/ put ESP32 Sketch Data Upload

9} Board: "RockFLY"

Upload Speed: "921600"

CPU Frequency: "240MHz (WiFi/BT)"
Flash Frequency: "80MHZ"

Flash Mode: "QI10"

Flash Size: "16ME (128Mb)"

Partition Scherne: "16M Flash (3MB APP/12.9MB SPIFFS)"

Core Debug Level: "Mone”
PSRAM: "Disabled”

Arduino Runs On: "Caore 1"

Events Run On: "Core 1"

Erase All Flash Before Sketch Upload: "Disabled”

JTAG Adapter: "Disabled”

Port »

Get Board Info

Programrner b

Burn Bootloader

4. Copy Libraries & Compile Source Code

e In this link you can download files.

https://cdn.ozdisan.com/content/rockflymini/RockFly_Mini_vO01.zip



5. UPLOAD

e After connecting the Rockfly board to the computer in the usb port, you can
select the port inTools menu.

File Edit Sketch Tools Help

RockFIyMini_G

[T T V6 Y 0 T % B i T % |

[T % B

#inclu
#inclu
#inclu
#inclu
#inclu
#inclu

#inclw

B #inclu

e I

W

#inclu
#inclu

#inclu

{/WIFI
#defin
#defin

const

Auto Format

Archive Sketch

Fix Encoding & Reload
Manage Libraries...
Serial Monitor

Senial Plotter

ESP32 Sketch Data Upload
WIFI101 / WiFiNIMA Firmware Updater

E5P32 Sketch Data Upload

Board: "RockFLY"

Upload Speed: "921600"

CPU Frequency: "240MHz (WiFi/BT)"

Flash Frequency: "80MHz"

Flash Mode: "QIO"

Flash Size: "16ME (128Mb)"

Partition Scheme: "16M Flash (3MB APP/12.9MB SPIFFS)"
Core Debug Level: "Mone"

PSRAM: "Disabled”

Arduine Runs On: "Core 1"

Ewvents Run On: "Core 1"

Erase All Flash Before Sketch Upload: "Disabled”
ITAG Adapter: "Disabled”

Port: "COMT"

Get Board Info

Programmer

Burn Bootloader

Ctrl+T

Ctrl+Shift+|
Ctrl+Shift+M
Ctrl+Shift+L

L

L

u/ms5611 driver ,but s
ESP32Time

ne/SimpleRalmanFilter

—arduinc/Vector

FOLLOWING PARAMETERS

Serial ports
COM3

[FI_CONNE(

const mmmrymmﬂﬂ*:—/mrmﬂlwnrd (IF "WIFI CONNECT



ROCKFLY CONFIGURATION

In order for you to understand that the board is working correctly, it is activated at the beginning
with the red power led and the buzzer. The red led lights continuously and the buzzer beeps 7
times, then it starts to read the data.

ROCKFLY-MINI -WiFi AND WEB SERVER:

With the RockFLY-Mini altimeter without any wiring, we press the reset button and pull the
board after or before the flight. Then the buzzer beeps many times, and while the buzzer is
beeping or within 2 seconds after the buzzer, we press and hold the boot button for 2 seconds.
If there is a successful transition to WiFi mode, the blue LED will be active on the board. And we
can connect to the board from any device that supports WiFi.

On the RockFLY-Mini Web Server: -You can see the current data:
e Altitude: It was obtained from the pressure value measured by the MS5611 pressure
sensor. Altitude can be meters or feet.
e Speed: Calculated from differences in altitude. Speed can be meter/second(m/s) or mil
per hour(mph).
e Temperature: Measured by the MS5611.Temperature can be Celsius(°C) or Fahrenheit
(°F)
e E-match Short Circuit Information: on the web server you will see pyrol and pyro2
o pyrol: It is the e match of the Drogue parachute.
o pyro2:lt is the e match of the Main parachute.

if pyro1 or pyro2 is “0” e-matches not mounted to the terminal or mounted e-matches do not
transmit the current. ASSEMBLE NEW E-MATCH!!

if pyro1 or pyro2 is “1” e-matches have been successfully mounted to the terminal and the
mounted e-matches transmit the current. SUCCESSFUL

e Battery Voltage : The voltage divider is calculated with the circuit. Its unit is volts.
-You can change the main parachute altitude (minimum 1 meter maximum 30.000meter)
-You can change the metric or imperial measurement system.
-You can test apogee and main e-match before flight.
-You can see the flash memory fillrate before flight and clean it .
-You can download or delete the data of the last flight from the csv file registered with the flight
id (It can store flights up to 13MB flash memory.)



-You can see the statistical data of the last flight:

max altitude : Highest altitude in the last flight

max speed: Highest speed in the last flight.

max acceleration :Highest acceleration in the last flight.
apogee time : From ground pad until apogee time.
descend time : From apogee until ground.

flight time : Total flight time from ground pad to.
pyroActivationTimeUs : From apogee until pyro burn time.
apogeeFallSpeed : Average speed from apogee to main.
mainFallSpeed : Average speed from main to ground.
riseaccel : Average rise acceleration until the apogee.
fallAccel : Average fall acceleration from apogee until ground.

CAUTIONS

e -Do not touch the chips on the circuit board by hand. It can be damaged and inoperable
due to static electricity

e -Do not let the chips on the circuit board come into contact with metal parts. It will cause
a short circuit on the circuit and damage the board.

e Do not let the circuit board come into contact with liquid. Otherwise, it will cause short
circuits and damage the board

e -Do not launch your rocket when the wind speed exceeds 20 MPH. If you must launch in
high wind conditions, increase the Launch Detect Threshold as necessary to prevent

accidental ejection caused by strong wind gusts.

e Take your safety precautions when testing with black powder. Especially do not work
without wearing your safety glasses.

e -If the e-matches are connected on the circuit, do not energize the board without
assembling the rocket. Unknown mistakes will cause e-matches to be active. E-matches

that explode in your eyes or in your hand will harm you.

e Before each flight, start your flight by connecting to WiFi and checking the battery
voltage and whether the e-matches are connected correctly

e Do not rupture pressure sensor diaphragm with excessive pressure or sharp object.

e Definitely follow the preflight checklist in the proper operational sequence before flying.



PREFLIGHT CHECKLIST

Check all cable connections in order. Check with your hand or by pulling long pliers that
the wires are tightly connected to the terminal blocks. Make sure the battery is securely
mounted. Check all places connected with clips.

Prep rocket, install engine, do not install engine igniter.

Make sure the RockFLY-MiNi board's power switch is OFF.

Connect e-matches. Make sure e-matches and battery cables are not short circuited.
Since the circuit is not energized, there will be no problem. When you are sure that the
cables are not short-circuited, proceed to the next step.

Connect the e-matches to the black powder chamber. Then add the calculated amount
of black powder and protect it so that it does not spill out of the black powder chamber.
Make sure that all rescue apparatus are connected to the main and main parachutes,
respectively, and docking.

Turn ON the power switch of the RockFLY-MiNi board. You will see that the red led is
active and you will hear the buzzer sound. If you cannot see this scenario, check your
battery for the necessary energy by measuring it with a voltmeter. If the LED or buzzer is
not active on the board, although the battery status is healthy, the previous error on the
board may have caused a short circuit, replace it with a new board. If you hear the
buzzer, switch to WiFi mode and make sure the battery status and e-matches are
properly connected. By rechecking the battery or the e-match connection if there is a
problem with the battery health and the connection of the e-matches.After making sure
the battery voltage status and the connection of e-matches, proceed to the next step. If
the problem persists, repeat the same step.

Check the main parachute value. Does it match the altitude you preset? Is the selected
metric or imperial measurement system set correctly? If you want to update again, you
can update at this point.

Turn OFF the power switch of the RockFLY-MiNi board again.

Have your rocket inspected by RSO if applicable, install engine igniter, and place the
rocket on the launch pad.

Turn the RockFLY-MiNi board's power switch ON again.When the board works again,
the red led will light and the buzzer will beep. If this situation has occurred, the board is
now ready for flight.

Ignite the engine starter. Have a nice flight.



ROCKFLY-MINI -SIZE AND DIMENSIONS




ROCKFLY-MINI -POWER SWITCH

/

WOODOD®

HadHEH

e If you connect the cables in reverse, there will be no problem. RockFLY-Mini has
protection to prevent reverse polarity on the circuit.



